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Graphic File Display

    
The bottom portion of the main window contains the Graphic File Display, which provides a visual 
representation of the digital audio file that is currently loaded into WinDat.
The horizontal axis represents time (moving from left to right), and the vertical axis represents amplitude, 
or loudness. 
The Graphic File Display also provides a visual representation of the selected range    by displaying it in 
reverse highlight.
If you do not want to see the Graphic File Display, enable the No Wave    option from WinDAT's Options 
menu.



Status Area
The Status Area, located below the Graphic File Display, contains information about the current audio 
file:

*Mono/Stereo    - Indicates whether the audio file is mono or stereo.

*Sample Rate    - Displays the sample rate of the audio file, in kHz.

*Bit Length     - Displays the bit length of the audio file.

*Cur (Current) - Displays the current position in the audio file in the format: 
[Minutes:Seconds.Hundredths of seconds].

*File - Displays the length of the audio file in the format: [Minutes:Seconds.Hundredths of 
seconds].



New
Creates a new, empty file based on the settings in the Setup window.

New does not erase the contents of the Clipboard.



Open
Presents a dialog box to select the file that you wish to load. The Files dialog box also lets you select  
the file format that you wish to look for (.WAV or .VOC).



Save
Saves the currently loaded file to disk. If the file already has a name, it will be saved with that name. 

Otherwise, the Save As...    dialog box will appear.



Save As...
Presents a dialog box for naming and saving the current    file to disk.



Exit
Quits WinDAT.



File List
The bottom portion of WinDAT's File menu lists the last four audio files that you have opened or 
saved, with the most recently-opened file listed at position 1. This makes it easy to re-open any of the 
last four files you've worked on.

To open an audio file in the Files List, simply click on the desired file name.



Undo
Restores the file to the state it was in before the last    Edit or Transform operation.



Cut
Removes the selected range and shifts the rest of the file back to fill in the gap, similar to deleting text
in a word processor. The deleted data is placed in WinDAT's Clipboard.



Copy
              Puts a copy of the selected range in the Clipboard    without altering the file.



Paste
Inserts the contents of the Clipboard at the start of the currently-selected range (as indicated by the 
Start Marker), and shifts the data after that point to the right.



Mix Paste
Mixes the contents of the Clipboard    with the data in the current file, beginning at the Start point of 
the currently-selected range (as indicated by the Start Marker).



Select All
Selects the entire length of the file as the range. This is useful for executing an Edit or Transform    on 
the entire file.



Delete
Deletes the selected range , but does not move the data to the Clipboard .



Erase
Puts a copy of the selected range    in the Clipboard    and replaces it with silence.



Trim
Deletes all data except the selected range . The contents of the Clipboard remain unchanged.

Trim is useful for eliminating unwanted data at the beginning and end of a file you've just recorded. 



Insert Silence
Inserts a specified amount of silence at the Start Marker, shifting everything after the Start Marker to 
the right.



Normalize
Scales the amplitudes in the selected range    so that the peak value is converted to the maximum 
possible amplitude; the rest of the amplitudes are scaled proportionally. 

Normalize lets you optimize the loudness of files that have been recorded at too low a level, without 
introducing distortion.



Find Peak
The Find Peak Transform locates the highest level (amplitude) within the selected range, and then 
displays a dialog box with information about the peak.

Find Peak gives you a convenient way to locate unwanted peaks that may be causing distortion so 
that they can be Scaled, Deleted, etc.



Scale
The Scale Transform is used to increase or decrease the loudness (amplitude) of the selected range 
by a specified factor between .01 and 10.00.    For example, a scaling factor of 2.0 will double the 
amplitude, and a factor of 0.5 will halve the amplitude. 

Scale is useful for matching the loudness between different files when cutting and pasting between 
them.



Auto Audition
The Auto Audition option lets you automatically preview audio files simply by clicking on them from the
Files    list box.

Enable Auto Audition in the Options menu, then choose Open or Save As from the Files menu. When 
you click on a file in the Files list box, WinDAT will play that file until you click on another file or 
another control.



Auto Rewind
When the Auto Rewind option is enabled, WinDAT will automatically rewind to the beginning of the file
after it stops playing.



No Wave
When the No Wave option is enabled, the Graphic File Display will disappear and WinDAT's entire 
window will shrink vertically. 

The No Wave option is handy if you want to reduce WinDAT's size so that it can share your desktop 
with other applications. Additionally, it can help save time by eliminating the wait normally required for 
re-drawing the graphic file display (especially when you're working with large files), and it can help 
reduce the amount of system overhead when playing back files at high data rates. 

When you click on No Wave again to disable it, the Graphic File Display will return and WinDAT will 
be restored to its previous window height. 



Playback VU
When the Playback VU option is enabled, WinDAT's VU Meters will be active during playback.

Disabling the VU meters can help to reduce system overhead if you're experiencing problems playing 
back files at high data rates. 



Record VU
When the Record VU option is enabled, WinDAT's VU Meters    will be active during recording.

Disabling the VU meters can help to reduce system overhead if you're experiencing problems 
recording at high data rates. 



Always on Top
When the Always on Top option is enabled, WinDAT will always appear on top of any other 
applications that are running. This prevents WinDAT from getting "lost" when you're running several 
different programs.



Setup
Displays the Setup dialog box for selecting the File Format    (VOC or WAV), Sample Rate , 
Stereo/Mono , Bit Length/Data Format ,Temp Directory    and Work Directory . 

When a file is loaded, the Setup dialog box will always display the sample rate that the file was saved 
with.

When you choose OK from the Setup window, its settings are saved as WinDAT's new defaults.



Clipboard Window
Activates a window containing information about the contents of WinDAT's Clipboard, such as what 
file the data came from, the duration of the data, etc.

Clicking on the Clipboard window's Play button lets you audition the contents of the Clipboard before 
performing a Paste    or MixPaste    operation.

NOTE: WinDAT uses its own Clipboard format, which allows it to share data with OLE Client 
applications and other Voyetra programs, such as AudioView, Annotator, etc. It is not to be confused 
with the regular "Windows Clipboard".



Performance Tune
The Performance Tune window lets you adjust various WinDAT parameters to    eliminate problems 
playing or recording at high data rates. In general, you should only modify the default Performance 
Tune settings if you experience data rate problems. Such problems are indicated either by a file that 
cuts-off abruptly, or by a "Disk Could Not Keep Up With Digital Audio" error message.

Play Buffer (default=4 seconds) - Determines the size of the memory buffer that WinDAT will use 
during playback.

Record Buffer (default=8 seconds) - Determines the size of the memory buffer that WinDAT will use 
during recording.

Pre-Write (default=128 K Bytes) - When you are preparing to record, the Pre-Write setting will 
determine the size of the area on your hard drive that WinDAT will "pre-allocate" for the digital audio 
data (in kBytes).    This gives WinDAT access to a contiguous area of the disk, minimizing the 
overhead required to record the data.

Tips:

If you are experiencing problems during playback of a high data rate file (i.e. 44k, 16 bit, stereo), try 
increasing the value of the Play Buffer.

If you are experiencing problems while recording, try increasing the value of the Record Buffer.    You 
can also try increasing the size of the Pre-Write value.    It should be equal to the maximum size of the
file you will be recording (in Kilobytes).



Index
Activates WinDAT's on-line Help system.



About WinDAT
Displays information about WinDAT's date and revision.



Loading a File
To load a digital audio file into WinDAT:
1. Choose Open    from WinDAT's File menu.

2. From the Files dialog box, choose the file format    you want to load: VOC or WAV.

3. Move to the Files list box and select the file you want.



Playing a File
To play a digital audio file with WinDAT:
1. Make sure that your sound card is properly connected to your headphones, speakers and/or 
amplifier.

2. Load the file you want to play.

3. If necessary, use your sound card's Windows mixer utility to adjust the digital audio playback level. 

4. Click the PLAY button    in the Transport Controls area.



Rewinding
To rewind a file to the beginning (0.00), double-click the REWIND button    in the Transport Controls 
area.



Configuring the Setup Window
Before recording a file, you may want to set some of its parameters, such as Sample Rate , File 
Format , Stereo/ Mono , and Bit Length/Data Format. This is done in WinDAT's Setup Window.

To setup WinDAT for recording:
1. Choose Setup from the Windows menu.

2. Select the desired Sample Rate. Higher sample rates result in better audio quality, lower sample 
rates result in a significantly smaller file size.

3. Select the desired File Format (WAV or VOC); select Stereo/ Mono (if your sound hardware 
supports stereo); and select the Bit Length and/or Data Format .

4. Choose OK to return to WinDAT's main window.



Recording
WinDAT can be used in conjunction with your digital audio hardware to record any Microphone - or 
Line-level    audio source.

To record with WinDAT:
1. Configure the Setup Window as needed.

2. If you're recording from a CD or tape, "cue up" the material as needed. 

3. If necessary, use your sound card's Windows mixer utility to set the record level(s). 

4. Click the RECORD button. WinDAT will go into Record Standby    mode, as indicated by the 
blinking red LED on the Record button. 

5. Click the PLAY button    and WinDAT will start recording. 

6. Begin speaking into the microphone, or start the CD player or tape deck.

7. Click the STOP button    to stop recording.



Saving a File
To save a file, choose Save    from the File menu.

If you're saving a new file, you will be prompted to type in a file name.



Selecting the Range
Most of WinDAT's Edit and Transform    functions require that you specify the section or "range" of the 
file that you wish to edit. 

Method 1:
Click on the desired Start point in the graphic file display, drag to the desired End point, and then let 
go. This will highlight the selected range and load the appropriate values into the Start and End 
markers. 

Method 2:
You can mark the range Start and End points "on-the-fly" while listening. Play the file and when you 
hear the beginning of the section you want to select, click on the Mark Range Button . Hold the button
down as the file plays, and release it when you come to the end of the section. 

Method 3:
Click and drag on the Start    or End Marker    box and drag up or down to reach the desired Start or 
End time.



Adjusting the Start or End Points of the Range

Method 1:
Use the Start    or End Marker    boxes:

Click on the appropriate Marker box and drag up or down to increase or decrease the Start or End 
time.

Or, click anywhere on the upper half of the appropriate Marker box to increase the Start or End time 
by 1/100th of a second. Click anywhere on the lower half of the appropriate Marker box to decrease 
the Start or End time by 1/100th of a second.

Method 2:
Point and Shift-click in the Graphic File Display    to adjust the Start or End point (whichever is nearer) 
without affecting the other point.



Auditioning the Range
To hear the range, press the PLAY RANGE button.



Removing a Section of a File and Placing it in the Clipboard
Cut    deletes the selected range from the file and places it in the Clipboard. The rest of the file is 
shifted back to fill in the gap, similar to what happens when you delete text in a word processor.

To remove a section of a file:
1. Select the range of the file that you wish to remove.

2. Choose Cut from the Edit menu.



Auditioning the Contents of the Clipboard
To audition the contents of WinDAT's Clipboard, choose Clipboard from the Windows menu and click 
on the Clipboard window's Play button.



Pasting the Contents of the Clipboard
The Paste    command is used to insert the contents of the Clipboard at a specified point in either the 
current file or a different file.

To paste the contents of the Clipboard into a file:
1. Choose Clipboard from the Windows menu to verify that the desired data has been placed in the 
Clipboard.

2. If you want to Paste into a different file, load that file. Or, choose New from the files menu to paste 
into a new file.

3. If you're pasting to an existing file, select the point where you want to paste the Clipboard contents 
by designating it as the range Start point . Or, if you're pasting into a new file, the data will be pasted 
starting at 0.00.

4. Choose Paste from the Edit menu.

The contents of the Clipboard will be inserted at the desired point. Data after that point will be shifted 
to the right, similar to inserting text in a word processor.



Creating Composite Sound Files
You can use Cut, Paste, and Mix Paste in conjunction with WinDAT's Clipboard, to create a new file 
made up of sections from existing files. A typical use for this method would be to create a complete 
digital audio "soundtrack" for a presentation or other multimedia application. The finished soundtrack 
created in WinDAT could consist of different elements, such as speech, music, or sound effects, 
recorded digitally from a variety of sources.



Executing an Edit Command
The method for using most of WinDAT's Edit and Transform functions is essentially the same. 

To execute any Edit or Transform function:
1. Select the range .

2. Choose the desired menu item from the Edit or Transforms menu.

Some commands (like Scale or Insert Silence) also present a dialog box that prompts you to enter 
specific information, such as scaling factor or amount of silence. 



Modifying Files with the Transforms
WinDAT includes several functions called "Transforms" that allow you to efficiently work with and 
modify your digital audio files. Like the Edit functions, the Transforms operate on a selected range.

The Transform functions are:
Normalize 

Find Peak 

Scale 



Scaling the Amplitude (Loudness)
Scale is a very useful Transform that can be used to increase or decrease the loudness (amplitude) of
the selected range by a specified factor between .01 and 10.00. 

For example, a scaling factor of 2.0 will double the amplitude, and a factor of 0.5 will half the 
amplitude. This feature is useful for matching loudness between different files when cutting and 
pasting between them. 

To Scale the loudness (amplitude) of a selected range:
1. Select the range you wish to scale. Or, choose Select All from the Edit Menu to select the entire 
file.

2. Choose Scale from the Transforms menu.

3. Type the desired scaling factor (between .01 and 10) into the Scale dialog box; then choose OK.



Using Drag-and-Drop File Loading
WinDAT supports drag-and-drop file loading from the File Manager or other applications that support 
drag-and-drop sourcing, such as Norton Desktop for Windows, XTree for Windows, etc. This feature 
lets you load a digital audio file by simply clicking on the file name and dragging it into WinDAT.

To load a file into WinDAT with drag-and-drop:
1. Run the Windows File Manager (or other drag-and-drop compatible application).

2. From the File Manager, navigate to the directory where the desired file is located so that the file 
name is displayed.

3. Click and hold on the file name, and drag it into WinDAT. 

4. Release the mouse button anywhere inside WinDAT's Graphic File Display.



Using WinDAT's OLE Features
WinDAT is capable of functioning as an OLE Server application - you can use to link or embed sound 
files into OLE-compatible documents. You can also use WinDAT to edit your sound files after they 
have been inserted into the document.

WinDAT supports two different methods for inserting sound files into OLE-compatible documents:

Method 1:
In most cases, you'll simply want to embed an entire sound file into a document. The easiest way to 
embed an entire sound file is to use WinDAT's drag-and-drop OLE icon. 

1. Load or record the desired sound file into WinDAT.

2. Drag WinDAT's drag-and-drop OLE icon to the desired point in the destination document and 
release the mouse button.

Method 2:
If you want to use WinDAT to create an OLE link, or if you want to embed only a portion of a sound 
file, you can use the standard OLE methods, as further detailed in your Windows Users Guide.    

1. Load or record the desired sound file into WinDAT.

2. If you want to embed a portion of the sound file into your document, highlight the desired area in 
the Graphic File Display, and then choose Copy from WinDAT's Edit menu.

3. Click on the desired insertion point in the destination document.

4. If you want to embed the sound data that was copied to WinDAT's Clipboard in Step #2, choose 
Paste from the document's Edit menu.

Or, If you want to create an OLE link, save the file if necessary, then choose Paste Link from the 
document's Edit menu.

 

To play a sound object:
From within the destination document, double-click on the WinDAT icon representing the embedded 
or linked sound object you wish to play.

Or, choose Sound [VOY] Object, Play from the document's Edit menu.

To edit a sound object:
1. From the destination document, click on the WinDAT icon representing the embedded or linked 
sound object you wish to edit.

2. From the document's Edit menu, choose Sound [VOY] Object, Edit.

This will cause WinDAT to run, with the sound object already loaded.

3. From WinDAT, edit the sound object as desired. 

4. If you're editing an embedded sound object, choose Update [application name] from WinDAT's File
menu.

If you're editing a linked sound object, choose Save from WinDAT's File menu. NOTE: This will 
overwrite the original sound file.



Quitting WinDAT
To quit WinDAT, choose Exit from the File menu.



Bit Length/Data Format
Bit Length
Bit Length (also called "bit resolution" or "sample size") is the number of bits that are used to store 
each sample as a number. In general, the greater the bit length, the better the quality of the digital 
audio. 

8- bit digital audio is adequate for speech and for some music applications. However, 16 bit digital 
audio is preferable where more accurate reproduction is required.

NOTE: WinDAT cannot convert files between 8- and 16- bit formats.

Data Format
Some sound hardware also supports various data formats and/or compression schemes, such as 
ADPCM, ALaw, etc. For this type of hardware, WinDAT allows you to choose from a list of supported 
data formats from the Setup window.

For more information on the data formats and compression schemes supported by your sound 
hardware, refer to the WinDAT Users Guide.



Clipboard
When you Cut or Copy data, it is stored in a    temporary "holding place" called the Clipboard. The 
contents of the Clipboard can then be inserted into the same file or a different file by using the Paste   
or MixPaste    command.



File Format
WinDAT supports the two most common types of digital audio files for PC-based sound cards: VOC 
and WAV format. A digital audio file's format is indicated by its file extension (*.VOC or *.WAV). 



Line-level
Line-level refers to the level of a signal from a device such as a tape deck, CD player, etc. WinDAT 
can record audio from either a line- or microphone- level device.



Microphone-level
Microphone-level refers to the level of a signal from a microphone, which is significantly lower than 
that of a line-level device. WinDAT can record audio from either a line- or microphone- level device.



OLE
Windows supports a feature called Object Linking and Embedding, or OLE. OLE allows you to insert 
objects from one application (called the OLE Server) into documents created with another application 
(the OLE Client). OLE Client applications include Windows Write, Word for Windows, Microsoft Excel,
and many others.

WinDAT is capable of functioning as an OLE Server, allowing you to embed or link sound objects into 
OLE-compatible documents. This feature lets you add voice or sound annotation to your text 
documents, spreadsheets, etc.

For more information on OLE, refer to your Windows Users Guide.



Range
Most of WinDAT's Edit and Transform functions operate on a selected area of the file, called the 
"range".



Record Standby
Clicking the RECORD button    puts WinDAT in "Record Standby " mode, as indicated by the Record 
button's blinking red LED. 

When in Record Standby mode, WinDAT will start recording as soon as the PLAY button    is clicked.



Sample Rate
The rate at which the digital audio hardware reads the analog signal is called the "sample rate". 
Higher sample rates result in better audio quality, while lower sample rates result in a significantly 
smaller file size. For information on the sample rates supported by your sound hardware, refer to its 
hardware documentation.

WinDAT displays its current sample rate setting in the Setup Window .



Stereo/Mono
WinDAT can be configured to record and playback digital audio in either stereo or mono (provided 
your sound hardware supports stereo).

The current setting is displayed in the Setup Window .



Transform
WinDAT includes a number of functions, called "Transforms", that make it easy to work with and 
modify your digital audio files. The Transform functions are: Normalize , Find Peak , and Scale .



Temp Directory
WinDAT stores the contents of the Clipboard as a *.TMP file in the directory that you specify as your 
"Temp Directory".    The Temp Directory is selected in the Setup Window .



Work Directory
WinDAT uses a default directory called the "Work Directory" for storing your digital audio files. 

The Work Directory is selected in the Setup Window .



Rewind button
Clicking the REWIND button scrolls backward by either 1 second or 1/10th of the file length, whichever 
is smaller. 

Double-clicking the REWIND button scrolls backward to the beginning of the file (0.00).



Stop button
Clicking the STOP button stops playback or recording.



Play button
Clicking the PLAY button initiates playback of the file.

Playback always starts from the current position in the file, as displayed by the Current position 
marker in the Range Controls area.

When WinDAT is in Record Standby    mode, clicking the PLAY button initiates recording.

Since WinDAT overwrites the entire file when it records, recording always starts at position 0.00.



Record button
Clicking the RECORD button toggles WinDAT in and out of Record Standby mode.

Record Standby mode is indicated by the RECORD button's blinking red LED.

When in Record Standby mode, clicking the PLAY button initiates recording.



Fast Forward button
Clicking the FAST FORWARD button scrolls forward by either 1 second or 1/10th of the file length, 
whichever is smaller. 

Double-clicking the FAST FORWARD button scrolls forward to the end of the file.



Play Range button
Clicking the Play Range button initiates playback of the selected range.



Start Marker
Displays the Start time of the currently-selected range in the format: [Minutes:Seconds.Hundredths 
of seconds].

Click on the Start Marker box and drag up or down to increase or decrease the Start time.

Or...

Click anywhere on the upper half of the Start Marker box to increase the Start time by 1/100th of a 
second.

Or...

Click anywhere on the lower half of the Start Marker box to decrease the Start time by 1/100th       of a
second.



End Marker
Displays the End time of the currently-selected range in the format: [Minutes:Seconds.Hundredths 
of seconds].

Click on the End Marker box and drag up or down to increase or decrease the End time.

Or...

Click anywhere on the upper half of the End Marker box to increase the End time by 1/100th of a 
second.

Or...

Click anywhere on the lower half of the End Marker box to decrease the End time by 1/100th of a 
second.



Mark Range button
This button lets you mark a range "on-the-fly" as you listen. 

When you hear the beginning of the section you want to select, click on the Mark Range Button. Hold 
the button down as the file plays, and release it when you come to the end of the section. 



VU Meters
The VU meters provide a graphic display of your record and playback levels.

To prevent distortion when recording, reduce your record levels if the signal reaches the top red LED.



OLE Drag-and-Drop Icon
With WinDAT's unique drag-and-drop icon, you can conveniently embed sound files into OLE Client 
applications (Windows Write, Word for Windows, Microsoft Excel, etc.) by simply dragging and 
dropping this icon at the desired point in the document.



Pause button
Pauses playback at the current location.    When you press pause again it resumes playing from the 
same location.



WAV -> VOC
Converts the current file from the Microsoft .WAV format to the Creative Labs .VOC format.



Change Speed
Allows you to change the apparent speed of the current file by converting the sample rate.    
Higher sample rates will make the file playback faster and at a higher pitch, and lower sample rates will 
produce slower and lower pitched playback.



File Info
Provides statistical information for the currently loaded file including; sample rate, bit resolution, 
length, size, format, etc.



 




